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The February 
25th meeting was 
our chapter’s 
opportunity to 
meet and inspire 
the technical 
communicators 
of the future, as 
well as to honor 
the winners of 
the 7th annual 
Florida High 
School Tech-
nical Writing 
Competition.  
In a show of 
strength, 
Winter 
Springs High 
School students dominated 
the competition by garnering 
11 out of 17 awards.  There 
were 61 entrants this year, 
representing nine high 
schools in four counties. 

Our keynote speaker was Dr. 
Suzy Behel, science teacher at 
Lake Brantley High School, 
and longtime supporter of the 
competition.  Dr. Behel de-
scribed how high school in-
structors can leverage writing 
competitions and other tech-

niques to improve their stu-
dents’ writing ability. 

“Communication is an integral 
part of our society,” she said.  
“It is the single most important 
asset that we have.  The STC 
competition has formed the focal 
point for teaching technical writ-
ing at Lake Brantley.  Not only 
does it provide excellent reward 
incentives, it offers specific writ-
ing guidelines that are especially 
helpful.” 

The top two writing contest 

awards went to a pair of 
Winter Springs sopho-
mores, Eric First and An-
drew Lai.  Each received 
an Excellence award and 
a $150 cash prize.  First’s 
essay was entitled 
“Augmented Reality: A 
Vision of the Future”; Lai 
wrote on 
“Miscommunication: The 

Role of Cell Cycle 
Regulators in the 
Development of Can-
cer.” 

Two more tenth 
graders, Bonnie Li of 
Lake Brantley High 
and Alexia Ash of 

Winter Springs, captured 
Merit awards and $75 prizes 
for their essays, “The Sci-
ence Behind Photography” 
and “The Evolution of Com-
puter Control,”  respectively. 

The top four papers have 
gone on for further judging 
in the annual international 
high school technical writing 
competition sponsored by 
STC.  Results will be re-
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Winter Springs H.S. students took home the lion’s share 
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writing contest. 
(Back, from left:  Mrs. Trent Daniel, Ryan Harvey, Alexia Ash, Kath-
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Tarkowski, Meghan Falter, Lauren Brinton, Jillian Tellez, Paulina De-

laCruz, Dr. Maureen Warner.) 
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leased in April.  Historically, Central 
Florida students have performed well 
in the international competition, in-
cluding a 1-3-5 finish two years ago. 

In addition to the four Excellence and 
Merit awards, we presented six 
Achievement awards with $25 prizes 
and seven Honorable Mentions. 

High School Writing Competition, cont’d 
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STC Annual Elections 
Voting materials for STC's 2003 election 
will be available online, therefore you will 
not receive hardcopy versions of these 
materials. You'll find candidate statements 
and an online ballot at www.intelliscaninc.
com/stc.htm.  

Please review these materials carefully 
before casting your vote. 

To log on to the election site, you'll need 
your ballot control number (34382) and 

your STC member number. (Your member 
number appears on your membership card 
and on the label of most mailings from the 
Society office.)  

To participate in the election, you must vote 
online by 12:00 noon EDT, April 15, 2003, . 

Have a say in STC's future: vote today! 

If you have any questions regarding the 
voting procedures or election materials, 
please contact Anita Dosik at anita@stc.org. 

Since the start of the competition in 1996, 
Central Florida high school students have 
earned $4,325 in cash prizes from STC for 
their writing prowess.   

A complete listing of the award winners, 
including the titles of their essays, is avail-
able at www.stc-orlando.org/education/
highsch/allhsawards.asp. 

Dewidowfication (n.)  (1) The removal 
of single-word carry-over lines in a col-
umn of text to save space and improve a 
document’s design appearance, 
achieved by editorial adjustments els e-
where in the paragraph. (2) The re-entry 
into a nuptial state of a woman whose 
previous spouse is deceased, with a new 
partner.  Root word is widow (n.), mean-
ing  (1) a single word of text that falls on 
a separate line at the end of a paragraph 
(typography) or (2) a woman whose hus-
band has died of natural causes 
(misfortune) or been done in 
(emancipation).  Other forms include 
dewidowfy  (v.t.), meaning (1) to remove 

a single-word carry-over line in a column of 
text or (2) to enter a nuptial state with a 
woman whose previous husband is de-
ceased; and rewidowfy  (v.t.), meaning (1) 
to reintroduce (albeit unintentionally) wid-
ows into a document during a text revision 
cycle, necessitating a subsequent correc-
tive action known as redewidowfication 
(n.) (from redewidowfy [v.t.], to dewidowfy 
again) or (2) to render a former widow a 
widow once again, either by killing her sec-
ond husband, or, if one is her second hus-
band, by dying, either via natural causes or 
via a deliberate act, such as autodefenes-
tration (see “Word Mint II,” V2N7 of Memo 
to Members).  Examples: (1) “We can cor-

rect the two paragraphs of overflow text in 
the brochure layout via assiduous dewid-
owfication” (typography).  (2) “Claudius 
widowfied and dewidowfied Gertrude 
within 2 months, via fratricide and incest, 
respectively” (Hamlet).  (3) “After Marsha 
defenestrated Harry following his steadfast 
refusal to autodezombify  (v. reflexive) (see 
“Word Mint I,” V2N6 of Memo to Mem-
bers) from Monday Night Football, she was 
dewidowfied and subsequently defenes-
trated by an opportunistic young gigolo 
who had handled Harry’s portfolio at 
Merrill Lynch” (investment). 

Dr. Jones,  Dr. Behel, and Mr. Kessler—
three key reasons for the success of our 

high school writing competition. 

Collect the Complete Set! 

Another New Release from the Orlando Word Mint …  
Our Motto:  If It Ain’t in the Dictionary, Make It Up 

http://www.stc.org/50thConf/
mailto:anita@stc.org
http://www.intelliscaninc.com/stc.htm
http://www.stc-orlando.org/education/highsch/allhsawards.asp


Page  3 

A year ago I was facing my second layoff in less than a year. 
I was able to find a new job within a few weeks despite the 
hard times in our industry. Here are my tips for finding the 
right job quickly and making the most of your time without a 
job. 

Make a Schedule 

Job-hunting can be discouraging, so procrastination is an 
easy trap to fall into. Attack the search in the morning before 
you can come up with reasons to wait. After you finish your 
daily tasks, you can spend your afternoons indulging in 
guilt-free loafing. 

It is also important to establish structure in your daily rou-
tine. Create a list of tasks to complete every day, week, and 
month. For example, list each job Web site you check on your 
task list. Another task might be to call your recruiter or to 
attend an STC meeting. Completing the tasks ensures that 
you do your job searching consistently and gives you a 
sense of accomplishment. 

Get There First 

In a perfect world, human resources would carefully read all 
the resumes they receive to find the best candidate. Unfortu-
nately, most Human Resources departments are swamped 
and interview the first 3–5 applicants who meet the minimum 
requirements. Consequently, it is important to be one of the 
first qualified people to apply to a job. Here are some ways to 
“speed up” your job application process: 

• Create a master cover letter with bullet points covering 
the skills for which employers commonly ask. When you 
apply to a job, choose the four or five most relevant bul-
let points for your letter. This allows you to customize 
your application without spending hours painstakingly 
crafting it. Also, since you’ll carefully proofread the mas-
ter letter, you won’t discover embarrassing typos right 
after you click “send.” 

• Create multiple versions of your resume. If you are tar-
geting two different types of jobs, create different re-
sumes for each purpose. Don’t try to make an “all pur-
pose” resume or customize it for each job application. 
Having a targeted resume ready means you can apply 
immediately when you find the right job. 

• Create your resume in multiple formats. Different employ-
ers ask for different formats. At a minimum you should 

Making the Most of Unemployment 
by Gena Shurtleff, Senior Technical Writer at IDX Corporation 
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have each version of your resume available as Microsoft Word 
and nicely formatted text files. The text version can be pasted 
into online applications. Again, since it has been proofread, 
you’ll avoid putting typos into those online forms. 

Rejuvenate Your Portfolio 

Having a great portfolio is important for technical communicators. 
There is no better time to improve your portfolio than when you are 
unemployed. This is one of the few times you have the time and the 
motivation. 

• If your portfolio is a little thin, try volunteering your time to a 
non-profit organization. Include the new work in your portfolio. 

• If your portfolio is paper-based, try creating an online version. 
Employers love being able to see your samples before the inter-
view. 

• If your portfolio is out-of-date, add recent work and give it a 
facelift. 

Sharpen Your Technical Skills 

The ability to use specific software applications is one of the most 
common job requirements for a technical writer. Why not spend your 
time off learning a new software application or working on a “soft 
spot” in your skill set? 

• Download a trial version if you can’t afford the product. Trial 
versions are free, and they provide a built-in deadline because 
they only last for 30 or 60 days. 

• Complete the tutorials. Many applications have tutorials that 
allow you to master the product’s basic capabilities. Create a 
sample for your portfolio using the product. This won’t give 
you true working knowledge of the product, but it will prove 
that you can use it. 

Stay Positive 

It can be a real challenge to remain upbeat in the face of unemploy-
ment. Have faith in yourself and your skills. Before you know it, 
you’ll be at work chasing deadlines and wondering why you were in 
such a rush to get back. 

This article was reprinted with the permission of author  
Gena Shurtleff and Managing Editor Kelly Malleck from the Puget 
Sound Chapter STC’s newsletter Sound Off! 
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This month I want to pro-
vide a friendly reminder to 
be sure to keep a few dif-
ferent versions of your 
resume on hand.   

As writing to your audi-
ence is important in tech-
nical communications, so 
is writing to your audi-
ence in your job search.  

You will want to tailor your resume (and cover le t-
ter) to suit the type of position you’re seeking.   

Rearrange your resume as necessary to feature 
what’s important based on the job description and/

or job title you’re seeking.   

By keeping these resumes on file, you’ll eventually 
have plenty of modular resume pieces that will make 
customizing your resume much easier in the future.   

In this tight job market, you’ll only have about seven 
seconds to catch the eye of those reading your re-
sume.  Be sure it shouts what the reader is seeking. 

Richard Phipps is the Consulting Services Manager 
for CIBER, Inc, an international information technol-
ogy consulting company.  Prior to that he served as a 
recruiter and a recruiting manager in his 6 years with 
CIBER..  Contact Richard at RPhipps@CIBER.com. 

Technical Writer Position Open at Publix Super Markets, Inc. 

• Demonstrated ability to publish docu-
ments to an Internet/Intranet environ-
ment is preferred. 

• Ability to solve problems and think 
creatively. 

• Ability to plan, organize, and follow 
through on assigned tasks. 

• Demonstrated ability to work well un-
der pressure and handle deadlines. 

• Must be detail-oriented. 

• Ability to work with minimal supervi-
sion. 

• Must show enthusiasm, initiative, and 
pride in work. 

Pay Information:  

The pay type for this position is monthly 
salaried with a range starting at $2,590 and 
ending at $3,600. Selected associate may 
not start at the base pay for the position 
(an individual's pay will be based on how 
well he/she meets the posted qualifica-
tions).  

Publix Super Markets, Inc. currently has a 
Technical Writer position open in the Infor-
mation Systems Department. March 27, 
2003 will be the last day that they will ac-
cept resumes for this position.  

Anyone interested should meet the follow-
ing qualifications: 

• Bachelor's degree in technical commu-
nication, English, journalism, or a re-
lated field, or a minimum of five years 
equivalent experience. 

• Demonstrated expertise in designing, 
organizing, writing, and editing usable 
system documentation. 

• Outstanding written and verbal com-
munication skills. 

• Ability to analyze information and or-
ganize ideas logically. 

•  Proficient user of MS Word. 

• Ability to work well with others and be 
a team player.  

• Outstanding interpersonal and inter-
viewing skills.  

To Apply: To apply for this position, 
please send in a resume, a statement of 
interest describing how you meet each of 
the qualifications, and reason(s) for 
wanting this position, a cover sheet, and 
several relevant writing samples to Teri 
LaCoy at Publix.IT.Jobs@Publix.com or 
fax the above information to Teri at 863-
616-5658. 

Students are Welcome to Apply 

If there is a student that is interested in 
this position, please have him or her 
send their resume, a statement of interest 
describing how they meet each of the 
qualifications, reason(s) for wanting this 
position, and several relevant writing 
samples to publix.it.jobs@imc.publix.
com.  

 

All candidates with the above qualifica-
tions are encouraged to apply regard-
less of race, gender, age, national ori-
gin, religion, marital status, or disabil-
ity.  

mailto:publix.it.jobs@imc.publix.com
mailto:Publix.IT.Jobs@Publix.com
mailto:RPhipps@CIBER.com.
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Budget is Balanced; Future is Bright 

Special Needs SIG Completes Successful Membership Drive 

Did I Ever Tell You, You’re My Hero? 

wide SNSIG membership drive that reached nearly all 150 
chapters as well the other SIGs.  The volunteers will be ac-
knowledged in the “Starfish Chamber” column in the next 
issue of the SIG newsletter, Achieve! 

SIG manager Dan Voss reported that via a mid-year budget 
adjustment based on its membership 
growth, strategic budget cuts, private 
donations, and the promise of corporate 
sponsorships, the organization is now 
looking at a balanced and viable budget 
that will sustain all of its initiatives in the 
2002-2003 chapter year, including its 
efforts before and at the upcoming con-
ference, as well as the likelihood of sig-
nificant budget growth in 2003-2004. 

Most important, he said, was the fact 
that the SIG has added a great many energetic new col-
leagues who stand ready to join in its diverse initiatives.   
Many already have. 

“Operation Starfish is complete,” he concluded.  “Its mis-
sion is accomplished.  We are viable, we are funded, and our 
future is assured.  Now we can return to our original mis-
sion: making this a more accessible world.”  

As of 2/27, with 98% of the STC membership renewal 
“precincts” in, the membership of the Special Needs SIG 
had grown to 222.  In all, STC had processed 22,730 
memberships, which is certainly good news for the Soci-
ety. 

The Orlando Chapter played a major role 
in the SNSIG’s successful membership 
drive, both in terms of the number of mem-
bers it has in the SIG and also by being 
the home of two of the SIG’s senior offi-
cers and at the epicenter of an intensive 6-
month membership drive. 

The 222, which is likely to grow to about 
230 with “stragglers” on the membership 
renewals and to around 250 by the end of 
the year with an influx at the conference, 
leaves the SNSIG shy of its original target of 300 to 
cover its budget request on a per capita basis (i.e., using 
the $5 SIG fees as its only source of income), but it 
nonetheless represents a phenomenal growth of 1,110% 
in less than a year, from a committee of 20 people to a 
robust and dynamic SIG. 

To a significant degree, the SIG owes this success to the 
dedicated efforts of a small band of volunteers who con-
ducted what it termed “Operation Starfish”—a world-

Chapter president Mike Murray told a packed 
house precisely that about Barbara Odom at 
the February chapter meeting. 

Mike made Barbara the second recipient of the 
chapter’s coveted “Hero Award,” bestowed 
for service above and beyond the call of duty 
under emergency circumstances. 

In this case, the emergency came at the Janu-
ary chapter meeting, which drew what may 
have been an all-time chapter record of 86 
people—none of whom would have been fed 
if Barbara hadn’t come to the rescue. The 
emergency was that the caterer thought the 
meeting was on Wednesday.  Barb discovered 

that juicy little tidbit of information about 20 
minutes before the meeting. 

No problem.  After defibrillation, Barb rapidly 
assembled a team of volunteers and dashed 
off to a nearby Albertsons.  Within a half 
hour, they were back bearing a very respect-
able array of refreshments, and the meeting 
came off on schedule. 

Rumors that several other Albertsons cus-
tomers were left sprawled on the floor by the 
checkout counters are unconfirmed. 

Barbara Odom,  Our Hero! 
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Sometimes you can’t find a tool to use for a particular task. However, if you are using Microsoft Word, then 
there is a possibility that you can make your own tools that will do what you want them to do. For example, 
often when I am copying text from another Word document, I need to copy it without bringing into my docu-
ment all the style information carried with the copied text. Likewise, when I copy text from web pages into a 
Word document, I usually just want to bring in the text without all the HTML formatting that pasting it directly 
into my document brings. I could  choose Edit>Paste Special>Unformatted Text from the menu bar, but that’s 
a lot of steps for something I do so often. Instead I made a tool to do this for me at  the click of a button. 

The time you can save in deleting multiple steps in procedures can really add up quickly, and you will enjoy 
your work more if you can automate it. I’ll walk you through the steps of setting up Word to write macros if 

you have never done this before, and then I’ll give you the code for 
one of my favorite tools, PasteUnformattedText.  

I have used this code in Word 97 and 2000, but it should work for 
2002. If you are using Word 95, well, it’s time to upgrade. Word 95 
has a different language, so this code in this article won’t work. 

Begin by opening the Visual Basic Editor by choosing 
Tools>Macro>Visual Basic Editor from the menu bar (see Figure 1).  
The upper window is the Project Explorer, the lower window is the 
Properties Window. I usually close it because I seldom use it and I 
like to have lots of free screen space.  

Make sure that you have Normal selected in the Project Explorer, then 
choose Insert> Module from the VB Editor menu bar. This will open 
the Code Window, which is where you will type the code for your 
macro. 

Normal refers to your Normal.dot, the basic template for Word docu-
ments. You can store macros in three places in Word– in the Normal 
template, in a separate template, or in the document itself. By storing 
your macro in the Normal template, you make it always available.  

Next, type (or copy and paste) the following code into the Code Win-
dow: 

 
Sub PasteUnfText() 
''       by David Coverston Copyright 2000-2001 
''              All Rights Reserved 
 
On Error GoTo errHandler 
Dim msgBoxTitle As String 
msgBoxTitle = "Paste Unformatted Text" 
 
Selection.PasteSpecial Link:=False, DataType:=wdPasteText, Placement:=wdInLine, DisplayAsIcon:=False 
 
errHandler: 
If Err.Number = 5342 Then 
    MsgBox Prompt:="You have a graphic on the Clipboard", Title:=msgBoxTitle 

(Continued on page 7) 

Tool Tips: Word Macros Can Save Valuable Time 
By David Coverston 
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Figure 1 
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(Continued from page 6) 
    Exit Sub 
ElseIf Err.Number = 4605 Then 
    MsgBox Prompt:="You do not have any text on the Clipboard", Title:=msgBoxTitle 
    Exit Sub 
Else 
    Exit Sub 
End If 
 
End Sub 
Your Code Window should now look like Figure 2. 

 
 
 

 

 

 

 

 

 

 

Close the VB Editor now, and we will finish the tool by adding it to your toolbar and making an icon for it. To do that, open the Cus-
tomize dialog box by choosing Tools>Customize from the menu bar. On the Commands tab, select Macros in the Categories list box, 
then choose Normal.Module1.PasteUnfText in the Commands list box, see Figure 3.  Click 
and drag the command to your toolbar where you want your tool button placed. I put 
mine to the right of the Paste tool on my Standard tool bar. That way I have my PasteUn-
formattedText  tool next to my regular Paste tool.  

Right-click your new tool button and choose Default Style and Change Button Image 
from the context menu, see Figure 4.  I use the little jar of paste icon that is used as a icon 
for pasting in other applications. Now I have my choice of pasting formatted or 
unformatted text at the click of a button. 

 

 

 

 

 

Technical Notes: Two errors can occur with this macro when pasting from the clipboard as 
unformatted text. You may have a graphic on the clipboard, or you may not have copied any-
thing to the clipboard. The error handling routines account for both of these and display a mes-
sage box telling the writer what the error was. 

Tool Tips, cont’d 
 

Figure 2 

Figure 3 

Figure 4 
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learn how to organize their writing, and how to use PERT 
(Program Evaluation Review Technique), a methodology devel-
oped by the U.S. Navy to schedule, organize, and coordinate 
tasks within a project.   

Dr. Behel suggested that STC build on its successes by getting 
the word out to more science/technology teachers, holding 
seminars at local high schools, creating a competition Web site 
and placing the winning submissions on that site.   She also 
suggested rewarding sponsoring teachers and having cospon-
sors furnish the rewards. 

At our February meeting we presented the awards for the Sev-
enth Annual Florida Technical Writing competition. Dr. Suzy 
Behel, a science teacher at Lake Brantley High School who also 
teaches technical communication, was the keynote speaker. 

Dr. Behel's presentation, “The Benefits of Teaching Technical 
Communication,” explained the importance of effective commu-
nication in science. She said that scientists working with the 
theory of spontaneous generation were ineffectual because 
they lacked communication skills.  

At Lake Brantley, writing skills are taught early in their curricu-
lum.  Beginning with the ninth grade, writing an essay is one-
third of their grade in the AP classes.   

The STC competition forms a focal point for teaching technical 
communication skills, Dr. Behel said, providing guidelines for 
beginning writers, and polishing the skills of the more ad-
vanced. Students learn how to define a target audience, then 
write for that audience. They learn to evaluate the quality of 
information sources, format bibliographies, cite references, and 
use tools such as spelling and grammar checkers. They also 

In Defense of Basic Transport—Epilogue 
by Dan Voss 

The plucky, battle-worn 1987 Honda Civic that was immo r-
talized in a poignant personal paean in last month’s edi-
tion (V2N7) of Memo to Members has added yet another 
chapter to its illustrious saga. 

Days after the article appeared, the author was battling his 
way through the daily gauntlet down traffic-clogged I-4 
less than a mile north of the St. John’s River bridge when 
his blood was chilled by the tell-tale rumble of a rapidly 
deflating tire.  Simultaneously, he caught the harsh glare 
of flashing yellow lights in the rear view mirror. 

The sound, indeed, was a flat.  Had it occurred 60 seconds 
later, on the bridge, it could have had ugly consequences. 

The lights, as it turned out, belonged to a State of Florida 
Road Ranger, who just happened to be located directly 
behind the Civic when its left front tire decided to give up 
the ghost.  The friendly shield of the large service vehicle 
sheltered the little car as it pulled safely off the road onto 
a narrow sloping shoulder despite the hurtling rush hour 

traffic. 

The driver of the Road Ranger provided a hydraulic jack which made the 
tire change a 5-minute proposition despite the steep, surly angle of the 
shoulder.  He also had handy an onboard pneumatic air hose to reinflate 
the spare tire, which, of course, was also flat. 

Seven minutes after the tire blew, the little Civic, once again shielded by 
the watchful yellow flashers of the Ranger, rolled safely back into the 
fray on the bustling interstate. 

The author, of course, claims that not even the most diehard skeptic 
could possibly attribute such an event to mere chance.  The Memo to 
Members staff is counseling him, but the outlook appears bleak. 

February Meeting: 

The Benefits of Teaching Technical Communication 
Presented by Dr. Suzy Behel 

Dr. Behel, February’s keynote speaker 
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March Meeting:   

From Tina to Xena: A Recipe for Professional Empowerment 
Presented by Dan Voss and W.C. Wiese 
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Sun Mon Tue Wed Thu Fri Sat 

  1 2 3 4 5 

6 7 8 9 10 11 12 

13 14 15 16 17 18 19 

20 21 22 23 24 25 26 

27 28 29 30    

Apr i l  2003Apr i l  2003   

All  STC monthly meetings are 
held at 6:30 p.m. at the Winter 
Park Civic Center unless other-
wise specified. 

STC 
Monthly 
Meeting 

Administra-
tive Council 
Meeting 

At our next chapter meeting on March 25, Dan 
Voss and W.C. Wiese, managers in the Commu-
nications Department of Lockheed Martin Mis-
siles and Fire Control, will present a workshop 
program entitled From Tina to Xena: A Recipe 
for Professional Empowerment. Based on their 
shared experience, Wiese and Voss will also 
present this successful workshop for a third 
time at the 50th Annual Conference of the STC. 

Remember the immortal Tina the Brittle Techni-
cal Communicator? The program will provide 
realistic training in the martial art of technical 
communication – integrated strategic communi-

cation. Learn to view change as an opportu-
nity to increase your impact on the organiza-
tion. Identify your level of impact, your re-
sources, and your opportunities to control the 
solution.  

You’ll graduate as a fully empowered Xena 
who has earned the right to be respected as a 
strategic partner in the business. 

See you there! (Leave war ponies tied in the 
parking lot.) 
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Web Site: www.stc-orlando.org 
 
Mailing Address:     STC Orlando 
                                P.O. Box 540444 
                                Orlando, Florida 
                                32854-0444 

O R L A N D O  C H A P T E R  S T C  UCF Research Team Puts Wrap  
On STC Grant Project 

Contact Us 
 
President:               Mike Murray                                          Hospitality & Membership Mgr.:         Barbara Odom       
                                407 306-4681                                                                                                       407 831-5820        
                                mike.murray@lmco.com                                                                                     BCOdom@aol.com 
 
Vice President:       Bob Shydo                                             Education Committee Manager:         Dan Voss 
                                407 302-2735                                                                                                       407 356-6508 
                                bob@intuitive-info.com                                                                                      daniel.w.voss@lmco.com 
 
Secretary:               David Coverston                                  E-mail List Administrator:                    Dan Jones 
                                407 551-3444                                                                                                       407 823-5160 
                                Dcoverston@paysys.com                                                                                  djones@ucf.edu 
 
Treasurer:               Karen Lane                                            Employment  Manager:                       Richard Phipps 
                                407 421-7795                                                                                                       407 682-1300 
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Chapter Meeting Schedule 
• March 25– The Tina-Xena 

Transformation: A Recipe 
for Professional 
Empowerment 

• April 22- Employment Pro-
gression and Scholarship 
Awards 

• May 27- Panel Discussion 
on Help 

• June 24-  Year-end Ban-
quet 

This month marks the completion of the 
year-long research project under an STC 
grant to develop multimedia presenta-
tions in support of the Chapter’s educa-
tional outreach initiative to Central Flor-
ida high schools. 

Developed by Cindy Hauptner, Suzanne 
Shomate, and Bob Stultz under the over-
sight of Dr. Dan Jones and Dan Voss, the 
year-long project produced a 40-minute 
presentation defining the profession of 
technical communication in a manner 
suitable for a high school audience and a 
15-minute presentation describing the 
Chapter’s annual high school technical 
writing competition. 

Cindy and Bob gave a brief peek into the 
finished presentations after the presenta-

tion of awards to the winners in this year’s 7th 
Annual competition at the February 25 chap-
ter meeting.  The materials will be posted to 
an STC Web site in the near future for Soci-
ety-wide access and use.  They will also be 
available on CD upon request. 

Look for an interesting and informative fea-
ture article by Cindy and Bob in the April edi-
tion of Memo to Members presenting an in-
side view of what it’s like to try to produce a 
“Cadillac” on a Volkswagen-sized grant 
budget, as well as how challenging it can be 
to maintain one’s sanity while also doing 
voice-overs for animated characters! 
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